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How to Design and Publish Your Website
with KompoZer
taken from a tutorial by Christopher Heng
KompoZer is a WYSIWYG (What You See Is What You Get) web editor which runs on Windows, Macintosh and
Linux.

Overall Goals of this Tutorial
By the end of this tutorial series, you will have created a fully functional website with multiple pages, including
a main page, a working feedback form, a Reciprocal Links page, an About Us page, and a Site Map. Your
website will contain images, multiple columns, a form, links to other pages within your site, links to other sites,
text in different font sizes, and so on.
More importantly, you will know how to use KompoZer to create, design and publish your site so that you can
design new sites any time you want.
Note that this is a hands-on tutorial. To benefit from it, in fact, to even understand it, you need to follow the
steps as I describe them. The practical nature of this guide makes it difficult to follow or understand if you're
not doing the things mentioned.

Creating A Simple First Web Page
To give you an idea how simple it is to create a web page, first start up KompoZer.
You will be greeted with a window that contains a menu (the top line of the window that says "File Edit View
Insert..." etc), a few lines of toolbars (containing buttons like "New", "Open", etc), a left panel with a heading
"Site Manager", and a large pane on the right-hand side that has a tab called "Untitled". This large pane is
where you will design your web page.
Type the following into the KompoZer. You don't have to do anything special — just start typing. Note that you
can type whatever you wish — I'm just furnishing you a block of text as an example. For ease of explanation,
though, I will assume that you have typed the text here in the rest of the tutorial. Don't let that stop you from
being creative, though.
Shakespeare's Website
Tomorrow, and tomorrow, and tomorrow, creeps in this petty pace from day to day, to the last syllable of
recorded time; and all our yesterdays have lighted fools the way to dusty death. Out, out, brief candle! Life's
but a walking shadow; a poor player, that struts and frets his hour upon the stage and then is heard no more.
It is a tale told by an idiot, full of sound and fury, signifying nothing.
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When you type, you are typing into KompoZer's "Normal" mode. You can see which mode you are using by
glancing at the series of tabs at the bottom of the KompoZer window.
To see how your page appears in an actual web browser, click the "Preview" tab to enter KompoZer's
"Preview" mode. Return to the "Normal" mode before continuing. I shall assume that you are using the
"Normal" mode in this tutorial unless otherwise specified. The "Normal" mode is KompoZer's WYSIWYG editor
mode. When you type text in this mode, KompoZer converts it into a HTML web document behind the scenes
so that web browsers can recognize it as a web page. If you want to look at the HTML code that is generated
from what you just typed, click the "HTML Source" tab at the bottom of KompoZer. Remember to return to
the "Normal" mode when you've finished admiring the code.
Now save the page onto your hard disk. Do this by clicking on the "File" menu, then the "Save" item on the
menu that appears. A dialog box should appear asking you for the Page Title.
Note: For convenience, in future, I shall refer to this sequence of clicking on the "File" menu, followed by the
"Save" item simply as:
File | Save
There are shortcuts to saving a file in KompoZer, as there are for the many commands given in this tutorial. I
shall, however, leave the discovery of minor things like that to you and concentrate on the main task of
creating a web page.
When you use "File | Save", a dialog box will pop up, asking you to give a title to your page. Since this is the
main page of your website, you should enter the name of your website here. For example, if you are
publishing a personal web page, you might want to name your website "Shakespeare's Website" (without the
quotes) if your name happens to be Shakespeare. If you are publishing a company web page, the site name
should be your company's name, such as "ABCDEF Company" or the like.
Once you've finished with the title, click the OK button or simply hit the Enter key (or Return key on the Mac).
A new dialog box will appear, prompting you for a filename. Navigate to a directory (ie, folder) on your
computer where you want to save your page. Type "index.html" (without the quotes) into the file name part
of the dialog box. Do not accept the default name given in the dialog box. Do not use another name. Do not
use capital letters in the name (ie, uppercase). Most web hosts expect the main page of your website to be
called "index.html". Their computers are configured in such a way so that if you simply type your domain
name, like http://www.example.com/, the index.html file will be displayed. If you change the name to some
other name, this will not work as expected.
After you've saved the file, you will be returned to KompoZer's main window. Look at the top of the window at
the window's title bar. Notice that instead of the words "untitled", the title that you typed in earlier now
appears there.
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Uploading or Publishing Your First Web Page
Before we proceed to polish the page so that it looks at least half-way decent, we need to publish the page to
your web host. One reason we're going to do this now, even before we've finished the page, is that KompoZer
needs the information about your actual website's address (or URL) before it can correctly handle things like
links and images on your web page. So even though the page is probably an embarrassment to you at this
stage, please complete the following steps, or you will encounter problems later.
Don't worry about the page being so plain. If you've not advertised your website's address (URL) to anyone, no
one will even know your site exists, so this preliminary version of your page will be seen by no one but you.
People will not visit your site out of the blue just because you happened to sign up for a web hosting account
today. It's not that easy to get visitors.
Another reason that you're publishing your page at this time is so that you can get familiar with the major
stages in the design of a web page. Once you get this hurdle out of the way, and you know how to get your
web page from your computer into your web host's computer, you have mastered what is arguably the biggest
technical challenge a newcomer is likely to face. Don't let this scare you though — it's actually quite easy!
To publish the page, go to "File | Publish" (ie, the "Publish" item on the "File" menu). A "Publish Page" dialog
box will appear asking you for more details.
"Site Name" is the name that you want to give your website. Use the name that you gave to your website
when asked for the title earlier (ie, "Shakespeare's Website" or "XYZ Company" or whatever). This name is
only used by KompoZer internally, to refer to your site, but it's probably best to use the real name you
ultimately wish to give to your site to minimize any confusion later.
The "HTTP address of your homepage" field specifies the actual web address (or URL) of your website. If you
registered a domain name like "example.com" for your site, enter "http://www.example.com/" into this box.
This field is required because KompoZer will use this information to form links on your site. Be sure to enter
the "http://" prefix as well.
"Publishing server" is a bit more complicated to explain. When you signed up for your web hosting account
from a commercial web host, you would have been given a whole bunch of details by your web host. Among
these is something known as your "FTP address". FTP, or File Transfer Protocol, is the usual means by which
you transfer your web pages from your own computer to your web host's computer. Transferring your pages
from your computer to your web host's computer is known as "publishing" or "uploading" your pages.
For the purpose of this tutorial, I will assume that your web host told you that your FTP address is
"ftp.example.com". You should substitute your real FTP address everytime you see "ftp.example.com" in the
examples below.
Before you enter that address though, you will need to know which directory (or folder) you need to put your
web pages. Some web hosts require you to put your web pages in a directory named "www". Others require
you to put it in a "public_html" directory. Still others say that you are to put your web pages into the default
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directory that you see when you connect by FTP. And so on. Find out the directory where you're supposed to
upload your web pages to.
Once you've got all the details, you're ready to form the address you have to enter into the "Publishing
address" field.
If your FTP address is "ftp.example.com", and the directory that you're supposed to upload to is "www", enter
"ftp://ftp.example.com/www" here. Notice that you have prefixed "ftp://" to your FTP address
("ftp.example.com"), added a slash ("/") and followed it with your web directory name ("www"). If your web
host tells you to simply upload it to the directory you are logged into when you connect by FTP, then just enter
"ftp://ftp.example.com" here.
The "User name" and "Password" fields in the dialog box refers to user name (or login name) and password
that your web host assigned to you. It is needed so that KompoZer can connect to your FTP account and
upload (publish) your pages.
When you've finished completing the information, click the "Publish" button. KompoZer will proceed to
connect to your FTP account on your web host and upload your pages. There will be a dialog box that pops up
to tell you it is uploading your page. The box will automatically disappear when KompoZer has completed its
task.
If you get an error message from KompoZer, look through the guide above again and recheck all your settings.
Most of the problems at this stage are caused by one of the settings not being correctly entered. If you have
eliminated all possible errors in your settings and still get an "Unknown publishing error", check my FAQ on
this.

Testing the Web Page
Before you proceed further, you need to test the web page you have uploaded. This way, you will know
whether you've made any mistake when entering your details earlier.
Start up your browser. Type the URL (web address) of your website. This is the address that you typed into the
"HTTP address" field earlier. For example, type "http://www.example.com" if that is your URL.
If you've entered the "publishing server" earlier correctly, you should see the page you created earlier in your
web browser.
If you get an error like "No DNS for www.example.com" or "Domain not found", it probably means that your
domain name has not yet propagated to your ISP. Put simply, this means that you probably only just bought
your domain name. It takes time for a new domain name to be recognized across the world (usually 2 or more
days), so it's possible that your ISP has not yet updated its name servers to recognize your new domain. Some
web hosts give you a temporary address which you can use to access your website in meantime. If you have
that, use the temporary address to check that your site has been uploaded properly. Otherwise, you'll just
have to wait.
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If you get an error like "404 File Not Found" or you get your web host's preinstalled default page, you may
need to go back and check your "publishing server" field. You may have published your page to a location that
is not recognized by the web server as the default page to show when only your domain name is entered.
You can change the settings that you have just entered by accessing the "Edit | Publishing Site Settings" menu.
Then click the name of your website in the left pane, under "Publishing sites". One possibility for the page not
showing is that you did not specify the correct directory on your web site to publish your index.html page to. A
more remote possibility is that your web host requires that your page be named something other than
"index.html". This is very rare nowadays, so explore this last possibility only when you've ruled out all others.
At worse, ask your web host's support department or check their documentation for help.
If what you see is your domain parking page created by default when you first bought your domain name, it
may mean that you forgot to point your domain name to your web hosting account. I strongly recommend
that you go back and follow the steps given the How to Start / Make a Website in addition to following this
tutorial. As mentioned before, there's more to creating a website than just using a web editor.
If you get no errors at all, but see the page that you've designed earlier, congratulations! You've created and
uploaded your first web page. It may be a rudimentary page but you have successfully walked through all the
essential stages of designing and uploading a web page.

How to Add Images, Change Fonts & Colours, and Create Links
How to Change Font Faces and Point Sizes
In the first chapter, we typed the following text into KompoZer:
Shakespeare's Website
Tomorrow, and tomorrow, and tomorrow, creeps in this petty pace from day to day, to the last syllable of
recorded time; and all our yesterdays have lighted fools the way to dusty death. Out, out, brief candle! Life's
but a walking shadow; a poor player, that struts and frets his hour upon the stage and then is heard no more.
It is a tale told by an idiot, full of sound and fury, signifying nothing.
Let's polish up the page. As it stands, we have not specified the font face that your web page is to use. This
means that your page will appear in the default font of the web browser your visitor is using, whatever that
may be. For visitors using Internet Explorer on Windows, this usually means that the "Times New Roman" font
face will be used, unless your visitor has changed the default setting. Since the actual font face varies from
system to system, and browser to browser, it is usually best to specify that a particular font be used by the
browser everytime it displays your page, so that you have more control over the appearance of your web
page.
To do this, select the text of the entire page. This can be done with the mouse by dragging the mouse cursor
from the first "S" in "Shakespeare" to the full stop (period) after the last word. Alternatively, type Ctrl-A (type
"a" while holding down the key labelled "Ctrl") in Windows to select everything.
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From the "Format | Font" submenu, select either "Helvetica, Arial", "Times" or "Courier". I will assume that
you selected "Helvetica, Arial" in this tutorial. "Helvetica, Arial" (actually "Helvetica, Arial, sans-serif" although
the menu does not say it) means that the browser will try to use a font named "Helvetica" on the visitor's
computer if available, otherwise it will use the "Arial" font. If the latter is not available either, the browser will
try to use another sans-serif typeface. For the curious: the Helvetica and Arial fonts are very similar in
appearance. Arial is found by default in Windows systems, while Helvetica is available by default in a number
of other systems.
The appearance of the text should instantly change. If you are running Windows, the Preview window will now
show your text using the "Arial" font.
You can also change the point size of the font on the page. For example, if you think that the text of the
"Tomorrow, and tomorrow" paragraph is too small for your visitors (for example, your site caters to people
who need large print such as the elderly or the visually impaired), select the "Tomorrow, and tomorrow"
paragraph, and go to the "Format | Size" menu. You can experiment with the various sizes till the text of the
page is to your liking. Be careful not to make the text too small. What looks good on your computer with your
particular monitor resolution may be unreadable on a different system with a high resolution monitor.
Do not change the point size of "Shakespeare's Website". We will do this next, using a different technique.

How to Specify Headers and Titles
In web design lingo, the text "Shakespeare's Website" is actually regarded as the header of the paragraph, or
perhaps of the entire page. By convention, both in print and on the web, headers are usually in bold and in a
larger point size than the rest of the text on the page.
While it is possible to simply change the point size of the text using the technique described earlier, headers
are usually specified in a different way.
Select the text "Shakespeare's Website" at the top of the page. Go to the "Format | Paragraph" menu and
select "Heading 1". "Shakespeare's Website" should now be in a large point size and in bold.
You may have noticed from that menu that there are a variety of header styles - "Heading 1" to "Heading 6".
Although KompoZer will not prevent you from doing so, you should only use "Heading 2" after you have used
"Heading 1", "Heading 3" after you have used "Heading 2" etc. That is, "Heading 1" is meant to be used as the
topmost header in the hierarchy, with "Heading 2" used for the lower level section headers, and so on.
Note that even though you're using "Heading 1" for "Shakespeare's Website", it is still possible to control or
change the point size and font face using the method mentioned earlier.
Now save the page with "File | Save". If the "File | Save" option is disabled, use "File | Save As". KompoZer
may ask you for the filename again. Simply choose the "index.html" file, and click "OK" to replace the existing
version. Note that you must save your page before you go on to the next step, or KompoZer will disable
certain features that you will need later.
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How to Add Images
1. If you want to add an image to your web page, you must have a means of creating that image. For that,
you either need to have access to a graphics drawing program, or if you already have the picture on
paper that you can use (such as a logo that is printed on your company's letterhead), you will need to
scan that picture into the computer.
If you are creating your own pictures, you need a drawing program that can create either PNG, GIF or
JPG files.
Place the image file into the same folder as your index.html page. Alternatively, you may create a
subfolder named "images" in the directory where you saved your index.html file in the last chapter,
and copy your image file into it. If you don't know how to create a subfolder, just place the image in
the same folder as index.html.
2. For the purpose of this tutorial, I shall assume that your file is called "logo.gif". I recommend that you
name your files using small letters (that is, lowercase letters) with no spaces in the name. This avoids a
variety of problems that occurs when your filenames has capital letters (uppercase letters) and spaces.
To insert an image beside the words "Shakespeare's Website", position your cursor to the left of the
word "Shakespeare" (or whatever word you have typed in the header). Select "Insert | Image..." from
the menu. A dialog box will pop up asking you for the location of the image. Click the "Choose File"
button (next to the box for "Image Location") to select your image and click "Open".
3. Under the "Image Location" box, which should now contain the name of your image file, the "URL is
relative to page location" box should have a tick in it. If not, click it to enable it. If the box is grayed out,
it means that either you have not published your page before or you have not saved your file since
your last change or both. Click the "Cancel" button and fix the error before returning to this step. For
example, if you have not published it before, return to the start of this manual for more information on
how to do this. If you have already published your page previously and still encounter this error, it
means that you have not saved the file after making some changes. Do it before returning here.
4. In the "Alternate text" field, enter "Logo for Shakespeare's Website". The text you type here will be
displayed if the visitor uses a browser that does not display graphics or has the graphics display
deliberately disabled. It is also useful for people who are blind or visually impaired, and rely on speech
synthesizers to read web pages out aloud for them. As such, any time you add a picture, it is important
that you add some sort of descriptive text in the "Alternate text" field. As a side benefit, adding the
alternate text also improves your website's search engine friendliness, which is an important part of
website design if you want your site to have visitors.
5. Click the "Appearance" tab in the dialog box. You can now change the alignment of the image. Click the
down arrow in the box under the "Align Text to Image" field to display a menu with the options
available for that item. Select the item "Wrap to the right" on that drop down menu. This will cause
any text that follows your picture to move to the right of the image.
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6. Click the OK button. Your image should display to the left of the words "Shakespeare's Website".
Depending on the height of your image, it is possible that some of the words in the paragraph that
follows are also aligned to the right of the image.
7. Move your cursor to the start of the main paragraph, that is, move it to the first "T" in "Tomorrow, and
tomorrow". Select "Insert | Break Below Image(s)". The paragraph should now start below the image
and not wrap to the right of it as before. Note: You do not have to do this if your image did not affect
your main paragraph. To undo what you just did, click "Edit | Undo" on the menu. You can always use
"Edit | Undo" to undo something that you just did, if you decide that it was a mistake.
At this point, your page may or may not look good, depending on the size of your image. If your image is too
large and the text too small, the alignment will not look good. One way to fix that is to adjust either the size of
the image (use your drawing program) or the size of your heading.
If putting the image to the left of your header does not work too well, you can insert the image above your
header. To do this, delete the existing image by clicking on it with your mouse, and hitting the Delete key.
Next, insert a blank line above your header and move your cursor upwards to the blank line. Insert the image
as before, only this time, do not change the alignment of the image in the "Appearance" tab (just leave it set
to the default).
If you insert an image in this way, you may want to centre both the image and the header "Shakespeare's
Website" on your web page. To do this, click on the image once to select it. Then select "Format | Align |
Center". Similarly, to centre "Shakespeare's Website", select the text, and then use "Format | Align | Center"
from the menu again.

Background Colour and Text Colour
There may be occasions that you need to change the colour of certain aspects of your web page. For example,
you may wish to change the background colour of your page. To do this, select "Format | Page Colors and
Background" from the menu. Click "Use custom colors", and then the colour button beside "Background". You
will be presented with a dialog box with many colours to choose from. Select your preferred colour then click
OK to accept the changes.
If you are changing the colours of your background and text, be sure to select colours that will contrast well so
that your text can be easily read.

How to Create a Link to Another Page
In the chapters to come, we will create a number of other pages. In order for your visitors to reach those
pages, you need to add links to those pages.
To create a series of links to the other pages on your site, do the following:
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1. Move your cursor to the bottom of the page. Leave a blank line after the paragraph above. We will be
creating a navigation bar for this site at the bottom of this page.
2. Select "Insert | Link" from the menu.
3. Enter "Home" (without the quotes) in the box entitled "Enter text to display for the link". This will be
the underlined text that visitors will see.
4. For the "Link Location" field, enter "index.html".
5. Click the OK button.
6. Using the same procedure, add links to the following pages as well:
 About Us (aboutus.html)
 Feedback Form (feedback.html)
 Reciprocal Links (links.html)
 Site Map (sitemap.html)
Separate the links using spaces and a vertical bar (see box below).
Where's the Vertical Bar?
For those who don't know how to get the vertical bar (ie, "|"), you can find it on your keyboard.
The exact location, however, varies from keyboard to keyboard, which in turn varies from country to country,
manufacturer to manufacturer, keyboard model to keyboard model. On many keyboards, it's the same key as
the backslash ("\") character. If you use a US keyboard, look at the keys below or next to the backspace key. If
you use a UK keyboard, check the key next to the left Shift key. If it's not there, you may be using a different
keyboard model (with a different layout) from those I'm accustomed to. In such a case, just go through your
keyboard key by key, in a systematic manner, to look for it.
When you've finished putting up all the links, the bottom of your page should look like the following:
Home | About Us | Feedback Form | Reciprocal Links | Site Map
Select the entire line at the bottom, centre the line with "Format | Align | Center", and if you wish, change the
font to "Helvetica, Arial" as before.
At this point, your page should look something like the following. Since I don't know what picture you used nor
its size, I've put a placeholder in the diagram below:
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Writing the Real Content of Your Main Page
At this point, you have a working main page for your web site, except that the real text for the page has not
yet been written. You should now replace the header on the page (if you have not already done so) and the
quote from Macbeth with the real content of your site.
Here are some tips on what you can put on your main page.
1. Replace the header "Shakespeare's Website" with the real name of your website.
2. Visitors arriving at your site at the main page should be able to tell what your site is about. The text
and graphics in your site should work together to that end. This does not mean, though, that you have
to write a long story on your front page describing the purpose of your site or company. However,
simply putting a cryptic picture in place of the existing Shakespearean text will not help your visitors
figure out what your site or your company is all about.
3. Your main page should also allow visitors to access the rest of the site. For the purpose of this tutorial,
we have placed links to certain pages of the site that are found on a typical company website. If you
intend to have other pages, for example a page listing your products, you should create a link to that
page as well. Important: when creating filenames for these other pages, create names that do not
have any capital letters (ie, uppercase letters) or spaces in them. Spaces and capital letters in the
names might lead to problems in the future. See the article How to Create Good Filenames for Your
Web Pages if you want more information.
Once you've finished rewriting the text on the page with more appropriate content for your site, save the page
by clicking "File | Save". Next, you will have to republish the updated page to your site. Select "File | Publish".
When the dialog box appears, put a check in the checkbox for "Include images and other files" if it's not
already there. If you don't do this, your images will not be uploaded to your website. Finally, click the OK
button to allow KompoZer to upload your revised page to your web server.
Congratulations - you now have a functional main page for your website.

How to Make Your Links Change Colour When the Mouse is
Hovering Over It: Creating a Rollover or Mouseover Effect
How to Change the Mouse-Over Colour of a Text Link
1. Start up KompoZer and load your web page.
2. Click "Tools | CSS Editor".
3. A dialog box, entitled "CSS Stylesheets", should appear. To change the colour of every text link when
your mouse hovers over it, make sure that the "custom style rule" radio button is selected, then type
"a:hover" (without the quotes) into the blank field just above the "Create Style rule" button.
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4. Click the "Create Style rule" button.
5. The dialog box should change in appearance to show a new "Style rule" for the "selector: a:hover".
Look at the series of tabs at the top of the dialog box. Click the "Text" tab.
6. The "Text" tab allows you to change the colour of the words appearing in the link. To do this, look for
the line called "Color:" in the dialog box. It should be followed by a blank field and a rectangular
button, all on the same line. Click the rectangular button.
7. The "Text Color" colour picker dialog box should appear. Select a colour by clicking it. Notice that when
you do so, the "Hex:" field in the dialog box changes to contain a series of letters and numbers,
preceded by a hash ("#") sign. This is the text representation of the colour that you picked that will be
inserted into your web page. Click "OK" when you've finished selecting the colour.
8. Now click the "Background" tab at the top of the dialog box. The text colour that you changed earlier
only modified the colour of the words appearing on your page. If you want your text to have a highlight
colour, then you will also need to change the background colour of the words when the mouse hovers
over them.
9. Near the top of the dialog box, look for the "Color:" line again, and click the rectangular box at the end
of that line.
10. Once again, you will see a colour picker, this time entitled "Block Background Color". Select the colour
you want for the highlight and click OK.
11. Finally, click the "OK" button to dismiss the "CSS Stylesheets" dialog box.
You can check to see if your colour scheme is readable by clicking the "Preview" tab at the bottom of the
KompoZer window, and moving your mouse over any text link on your page. You should be able to see your
new rollover or mouseover colours at work.

How to Change the Default Colour of a Text Link
The above procedure only teaches you how to change the mouseover colours of a text link. If you want the
default text link colours to be changed as well, do the following:
1. Click "Tools | CSS Editor".
2. Look at the top of the dialog box that appears. There are four icons (buttons) above the leftmost
column. The first icon, or button, has a down arrow. Click the down arrow. A drop down menu should
appear. Click the "Style rule" item in that menu.
3. You should be returned to the "New style rule" page that you saw the first time you used "Tools | CSS
Editor". Once again, make sure that the "custom style rule" radio button is selected, and type "a:link"
(without the quotes) into the blank field just above the "Create style rule" button.
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4. Click the "Create style rule" button.
5. Go to the "Text" or "Background" tab, or both, to change the colour of the link. The procedure is the
same as when you modified it for the "a:hover" effect.
6. As before, click the "OK" button when you're done.

How to Change the Colour of a Visited Text Link
The colour of a link that has been previously clicked can also be changed. To do this, follow the above
procedure for "a:link", but instead of entering "a:link" in the blank field as you did earlier, enter "a:visited"
(again, without the quotes).

Some Things You Should Note Before Changing Colours
Although you have almost unlimited power to control the colours of all your links, there are usability
considerations that you need to think about before changing the default colours.
The default browser colours for the links, blue underlined text for unclicked links and purple underlined text
for ones that have been clicked before, are universally understood by web surfers everywhere. If you change
them from the default colours, your visitors may not realize that your uniquely coloured text are actually links
that can be clicked, mistaking them for an attempt to create a colourful page. Likewise, if you change the
colour for visited links, visitors may not be able to tell which links they have already visited, and which they
have not. This in turn reduces their efficiency when they move around your site, since it may force them to
reclick links just to find out if it leads to somewhere they have already checked. For this reason, many sites,
leave the default text link colours as they are, configuring only the hover effects.
Don't misunderstand me: I'm not saying that you should never change your link colours. Far from it. I'm sure
there are many web design colour schemes that will look awful if the links appear in their default blue. I'm
merely saying that before you go wild changing colours, remember that there are usability consequences to
having a non-standard colour scheme. By all means change colours when there is a need; but if the existing
link colours work fine on your site as is, leaving them at their default has definite advantages.
Note though that the above caveat does not apply to the hover (rollover) colours. Since there are no defaults
for that, adding rollover colours, if correctly done, may improve usability rather than decrease it.

How to Remove the Underlining from Your Links
Underlined Links and Usability
Before you wantonly remove the underlining from all the links on your site, be aware that links that are blue
and underlined, are more or less a standard on the Internet. Anyone used to surfing the web will instantly
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recognise such blue underlined text as links, and will know that they can click on it to get more information on
that particular item.
If you change your links so that they are no longer underlined, you are removing an important visual cue to
links on your web page. Your visitors may end up not realising that the text they are reading are really links.
Even if you change the colour of the text, they may misinterpret that different-coloured text as an attempt to
emphasize some words.
This does not of course mean that you should never remove the underlining from your links, or change their
colour. But you should be aware that what you do has certain consequences for the usability of your site. You
may also want to provide some other visual cue that the text is actually a clickable link.

Steps to Getting Rid of the Underlining from Your Links
1. Start up KompoZer and load the page that you want to modify.
2. Select the text that you want to make into a link (for example, by dragging your mouse over the
desired text). If you already have a link on your page that you want to modify, you should still do the
same (that is, select the entire text of the link).
3. Click the "Insert" menu. In the menu that appears, select the "Link..." menu item. In future, I shall refer
to such a procedure as "Insert | Link...". A dialog box labelled "Link Properties" should appear.
4. If this is a new link that you want to make, enter the web address (URL) for that link in the "Link
Location" space. For example, if the link is to point to "http://www.example.com/", enter
"http://www.example.com/" into the blank space in the "Link Location" section. If this is an existing
link that you selected, the URL should already be in the box so you can skip this step.
5. Once you enter something into that "Link Location" space, the "Advanced Edit" button in the lower
portion of that dialog box should be enabled. Click it. A new dialog box, labelled "Advanced Property
Editor", should appear.
6. Somewhere at the top of the Advanced Property Editor dialog box, you should be able to see a row of
three tabs: "HTML Attributes", "Inline Style" and "JavaScript Events". Click the "Inline Style" tab.
7. In the blank space under "Property", enter "text-decoration" without the quotation marks. Do not
change the word "text-decoration" in any way. That is, don't add spaces, change from the small letters
(lowercase) to capital letters (uppercase) or change my hyphen character into something else. Just
enter it exactly as I provided it here. One way to do this is to cut and paste the word "text-decoration",
without the quotation marks, into the box.
8. In the blank space under "Value", enter "none" without the quotation marks. Again, don't change
anything, just put the word "none" exactly as I furnished it.
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9. Click the "OK" button to dismiss the Advanced Property Editor, and then the "OK" button on the Link
Properties dialog box to accept your changes.
10. Your link should no longer show up as underlined in that editor.
11. Save the page, publish it and load it up in a real web browser to check that your linked text appears as
it should.

How to Create Data Tables
Creating Tables to Display Your Data
For this section of the tutorial, you will be creating a new page for your website: the "About Us" page. This
chapter will take you through the process of creating a page that looks something like the page in the diagram
below. You will of course have to modify the content to suit your site. The main idea in this section is to
introduce you to the use of data tables, which we will use (or misuse) to create multiple column layouts for
our site later.

Steps to Take
If you've been observing the websites that you visit you will have noticed the pages on a particular website
share a common design, with only the page-specific content differing from page to page. The common design
not only saves the web designer time when designing a site, it also helps visitors. A common layout among the
pages on a site make it easier for visitors to locate common elements like navigational links.
For this tutorial, we will use the index.html page that we created in the previous chapters as a template for
our second page.
Make a copy of the index.html that you created in the previous chapter, and call it aboutus.html.
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To do this in Windows, open up "My Computer" and navigate to the index.html file. If you can't find any file
named "index.html", only a file named "index", click the "Tools" menu in the "My Computer" window,
followed by "Folder Options". Click the "View" tab at the top of the options dialog box. Uncheck the box "Hide
extensions for known file types". Click the button "Apply to All Folders". Click the "OK" button. You should now
be able to see the full filenames of all your files.
Select the "index.html" file with your mouse. Right-click the file and select "Copy" from the menu that pops
out. Click a blank spot in that same window and right click it. Select "Paste". A new file, "Copy of index.html",
will appear. Right click the file and select "Rename". Change the name from "index.html" to "aboutus.html".
Start up KompoZer. Click "File | Open File". An "Open HTML File" dialog box will be displayed. Select the
aboutus.html file which you created in the step above and click the "Open" button.
KompoZer will display your new aboutus.html file. At this point, the page is identical with the index.html that
you created earlier. We will be changing this page to an "About Us" page. The "About Us" page on a site
typically gives your site's visitors information about a company (if yours is a company site) or about you (if
yours is a personal site).
Change the heading of the page from "Shakespeare's Website" to something appropriate for an "About Us"
page on your website. For example, if your site is a personal website, you can call it "About Me". If you want to
use that page as a resume, you can call it "[your name]: Resume" or [your name]: CV". If your site is a
company website, call it either "About Us" or "XYZ Company: About Us".
From the Format menu, click the "Page Title and Properties" menu item. Change the text in the Title field to
match what you used for the header earlier, and press the ENTER key.
Replace the quote from Macbeth with the "Here are some of my achievements:" or, alternatively, substitute
with the real content that you want on your finished site.
Hit ENTER a couple of times to leave a blank line before the start of your table.
From the menu, select "Table | Insert | Table..." A dialog box appears. The dialog box shows an image of a 6 x
6 table, with 2 rows and 2 columns selected by default. Below the image, the dialog box shows the number of
rows and columns currently selected in case you're too lazy to count the number of shaded squares yourself.
Basically we want to create a table with 5 rows and 2 columns. There are a couple of ways to create such a
table. One way is to move your mouse over the squares until you get a 5 x 2 table. For small tables like ours,
this method will probably suffice. However, this method limits you to creating a table with a maximum size of
6 rows by 6 columns. For this tutorial, you will be using the alternative method, which allows you to create
tables of any size you wish.
Click the "Precisely" tab at the top of the "Insert Table" dialog box. This new tab will allow us to specify exactly
how big the table is to be. Enter "5" (without the quotes) for Rows and "2" (again, without the quotes) for
Columns. Under width, the default is 100 % of window, which means that your table will fill out the entire
width of your web page. You can leave it set to the default. The "Border" value should be 1 pixel by default,
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which means that your table will have a border of one pixel surrounding its cells. You can leave that alone too.
Once you've finished, click OK or hit the ENTER key.
A table should appear on your screen. Complete the table using the data below. Alternatively, you can
complete it using your real content. To move to the different columns and rows in the table, use the TAB key.
Alternatively, if you prefer using the mouse, you can click in the appropriate cell to position your cursor. (Don't
worry about the constantly resizing columns.)
Year

Play / Achievement

1599

Julius Caesar

1600

Hamlet

1604

Othello

This year

Shakespeare's Website

Note: your table will not look exactly like the table in this picture. In particular, your table should fill out the
width of the browser, while the table in my picture does not. I mention this for the sake of those who might
worry that they're doing something wrong if their screen does not look the same as my image.
If you want to move the cursor outside your table, do not use the TAB key in the last cell. Use the arrow key
instead. If you use the TAB key there, KompoZer will automatically create another row in the table thinking
that you want to extend the table. If this warning comes too late for you, and you've already accidentally
created another empty row, you can easily delete it the extra row by moving your keyboard cursor to that row
and use "Table | Delete | Row" to get rid of it. It is also possible to undo mistakes immediately after you
commit them by using "Edit | Undo" from the menu.
Now look at your table. The first row of the table actually contains the header for the rest of the table. To
indicate that it is the header, move your cursor to the "Year" field, then select "Table | Table Properties". You
will be greeted with a dialog box with two tabs at the top: "Tables" and "Cells". Click the "Cells" tab. The dialog
box contents will change when you do so. Now change the "Cell Style" in that dialog box from "Normal" to
"Header". Click OK. Now move your cursor to the "Play" field of your table and do the same here.
You have indicated that the those two cells are headers for their respective columns. Browsers typically show
such headers by displaying them in bold.
If you like, you can select the entire table and change the font face to "Helvetica, Arial". Use the method
mentioned in Chapter 2.
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Preview the page, save it as "aboutus.html" and publish it. Go to your website and click the "About Us" link
from your main page, and you should be able to see this newly created page. You can return to your main
page again by clicking the "Home" button at the bottom of your "About Us" page.
Congratulations. You've created your first page with a table and used it to present data. In the next chapter,
we will use a table to control the positioning of text on your web page in order to create a multiple column
layout for your website.

How to Create a Multiple Column Layout for your Website
If you look at the design of many websites, you will probably notice that most of them have multiple columns
of text and graphics on each page. For example most pages have two columns: the left column holds the site
logo and navigation menu buttons while the right has the main content. It is possible to have more than two
columns too.
Since KompoZer does not allow you to arbitrarily position text and graphics on your web page, nor does it
allow you to easily create multiple columns using Cascading Style Sheets (don't worry if you don't know what
this is) from the WYSIWYG interface, you will have to use an old webmaster trick to accomplish this. Here is
where the table creation tips that you learnt in the previous chapter of this tutorial come into play.

Creating a Two Column Layout for Your Web Page
The aim of this section is for you to create a page that looks something like the following:

If you notice from the above picture, the page is a two column web page that will serve as your Reciprocal
Links page. The latter is where you can place links to other sites that either link to you or that you find useful.
If you decide to keep the two column layout you create here for your site after you finish this chapter, you
should go back to the pages you created in the earlier chapters and modify them. This allows your site to have
a consistent feel. That is, if you want a two-column layout for your site, change all the pages on your site to
have the same two-column layout. Likewise if you prefer a one-column layout or a three-column layout (and
so on), change them to have the same layout. This is not a hard-and-fast rule, just a general recommendation.
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Creating a Two-Column Layout: Steps to Take
1. The basic idea here is to create an invisible table that has the number of columns you want. The table
is configured so that it fills the entire width of the browser window.
2. Start KompoZer with a blank page.
3. Insert a table with "Table | Insert | Table". When the dialog box appears, click the "Precisely" tab at
the top of the dialog box. In the fields that appear in the dialog box, specify 1 row and 2 columns.
Leave the default width of "100% of the window" as it is. In the "Border" field, enter 0 to replace the
default border value. You are creating a table without any lines that occupy the entire width (100%) of
the window. Click OK when you are done.
4. Move your cursor into the left column (eg, by clicking in the blank space in that column with your
mouse), and type the text shown in the picture above. The underlined items in my diagram represent
links to the other pages on your site. They are the same links that you have been using in the earlier
chapters of this tutorial. For your ease of reference (if you have been using the same page names that I
have given in the earlier chapters), the links point to the following pages:
 Home (index.html)
 About Us (aboutus.html)
 Feedback Form (feedback.html)
 Reciprocal Links (links.html)
 Site Map (sitemap.html)
You might find that the links you create do not appear to have the traditional blue underline. This is
due to a longstanding bug in KompoZer. Don't worry - if you created the links correctly, they will be
there when your website is viewed by a browser even if it doesn't appear while you are creating the
page.
5. Before you carry on further, save the page. When prompted for a title for the page, enter "Reciprocal
Links". For the filename, enter "links.html". Don't get creative here (unless you know what you're
doing): if you change the filename or the title of the page at this point, you will need to go back and
change all the links that you have already created in the earlier chapters of this tutorial.
Once you have saved the page, you can open it in your web browser to verify that your links were
coded correctly and appear normal. You need to do this because KompoZer doesn't render the left
column correctly, making it difficult for you to check visually in the web editor.
6. Now move your cursor to the right column (eg, by clicking in it). Type the main content of your
Reciprocal Links page here. If you have no idea what to type, use the example text given in the picture
above as a temporary placeholder. The URLs for the links in the diagram are as follows:
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"please let us know" ( feedback.html ). Note that this sentence is just a placeholder until you get real
links to place here. Once you have something, you can delete the sentence "If you wish to exchange
link with us, please let us know" or, at your option, leave it above (or below) your list.

7. I'm sure you have noticed that the width of the right column expanded as you typed your text.
KompoZer mimics the behaviour of a web browser when rendering table columns that do not have an
explicit width setting. While a column that changes its width dynamically according to its content is
acceptable for most data tables, it is not what we want when we use (or abuse) a table as a container
for our page content. Another problem is that the text on your page is centered vertically, that is, if you
don't have much text in that particular column, it will appear in the centre of your page.
To fix this, move the cursor to the left column (eg, by clicking in it). Select "Table | Properties" from the
menu. Click on the "Cells" tab at the top of the dialog box that appears. Click the checkbox for "Width"
to select it ("Width" can be found in the "Size" section). Type 20 in the Width field. Change the drop
down box for "Width" from "Pixels" to "% of table". Under "Content Alignment", check the "Vertical"
box, and select "Top" from the drop-down box beside it. Click the OK button.
The left side of the table should change its width. If the width is still not acceptable for your content,
try again and use a different number till you are satisfied with the width of the left column.
Once you are satisfied with the width for the left column, repeat the procedure for the right column.
The width for the right column should be 80 if you used 20 for your left column (ie, 100% - 20% = 80%).
If you've used a number other than 20 for your left column, subtract that number from 100 to get the
value you need to enter. Remember to set the vertical alignment value to "Top" for this column as
well.
8. Many people use a different colour for their navigation panel (which is what the left column of your
page currently functions as) to distinguish it from the main content of your page. To do this, make sure
your cursor is in the left column, and select "Table | Table or Cell Background Color" from the menu.
Select a colour other than black, blue or purple. Actually, you are free to select whatever colour you
want. But if you select either black, blue or purple, you will find that some of the text becomes
extremely difficult to read under certain circumstances. If you can't decide, choose one of the yellowbased colours. For example, I selected the "#ffcc66" colour. (Every colour you choose has an associated
colour value. This value appears in the "Hex" field at the bottom of the dialog box. If you want to
choose the same colour I did, click on the colours until you find one that has "#ffcc66" appearing in
that field.)
9. If you have not already done so, you may wish to change the size of the text and the typeface used to
something other than the default. For example, I used the "Helvetica, Arial" option in the "Format |
Font" menu for the text. You can also use a graphic image with your site's logo in place of the text
"Shakespeare's Website". Make sure that the width of the logo is suitably narrow so that it can fit into
your left column when your site is viewed with a 1024x768 screen resolution. You may also want to
change the various titles or headers on the page, that is, "Shakespeare's Website", "Sites that Link to
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Us" and "Useful Sites", to use the header styles "Heading 1" and "Heading 2", as described in chapter 2.
Doing so will automatically switch those pieces of text to use a bold and large font.
When you're done with your changes, save the page and publish it.

How to Create a Three-Column (or More) Layout
Although you will not be creating any three-column page for the purpose of this tutorial, if you find you need
such a layout, simply enter the required number (eg, "3" for a three-column page) instead of "2" for the
"Columns" field when you create your table.

Special Cases
Sometimes you need to create a page that is basically two columns but with a single column either at the top
or at the bottom of the page. For example, you may want to put a banner at the top of the page that spans
both columns. Or you might want to put a copyright notice at the bottom of the page that stretches from the
left side of the page to the right.
The easiest way to do this in KompoZer is to simply place the banner or text before (or after) your table.
Another method is to create a table with more than one row, and join the cells in top row (or the bottom row)
so that there is only one column for that row.

Creating a Site Map
At this point, you have sufficient knowledge to create a respectable-looking website with multiple pages. You
can now consolidate your knowledge by creating (on your own) a Site Map for your website.
A Site Map is a page that links to every important document on your website. Such a page is a useful aid to
your visitors in case they want to locate a particular page quickly. It is usually present in well-designed sites
with multiple pages, and is one of the facilities that improve a site's usability. Although your site has only a few
pages at present, and all of them are listed in your left-column navigation panel, it is a good practice to always
create a site map for your sites (unless the site only has one or two pages).
You can use a column system for your Site Map (depending on how much data your site has to share) or your
Site Map can be a straightforward list of links to all your pages if you like. In fact, it is best to keep your Site
Map simple so that visitors can find what they want easily. Restrain yourself from making it into such a
graphical feast that your visitors have to solve a maze of visual puzzles before they can locate your pages.

How to Add a Feedback Form to Your Website
As you surf the web, you will probably have noticed that most of them have some sort of facility for visitors to
send a message to the webmaster. Some sites have a feedback or contact form, which is basically a form that
you can complete and send using your web browser. Other sites have their contact information, like email
addresses, displayed on a page on their site.
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Note that of all the sections in this manual, this chapter is probably the most difficult to understand, since it
involves many unavoidable technical aspects. However, even if you don't understand portions of it, you should
still be able to create a feedback form for your site by blindly following my step-by-step guide.

Overview: How a Feedback Form Works
There are many aspects to getting a working feedback form on your website: it is definitely more than simply
designing a web form with KompoZer. By way of overview, here are some of the major elements that we will
need. You do not need to understand every single detail at this point since I will take you item by item through
the whole process later. However, it is useful to have the big picture in mind so that you don't get lost in the
forest of details later.
1. The first thing we need is the web page containing the feedback form. You will be designing most of
this page using KompoZer. By itself, the form doesn't do anything at all: your visitors can click the
"submit" button till they are blue and you will still not receive their message. The task of sending the
form contents as an email message lies with what is known as the feedback form script.
2. The feedback form script is essentially a computer program that processes the contents of the form
sent by your visitor's web browser. It takes the raw message and formats it as a regular email message
and then sends it via email to the webmaster. This script has to run on the web host's server (ie,
computer) itself. You will be using a script custom designed for you by thesitewizard.com's Free
Feedback Form Wizard. However, you will have to find a web host that supports the running of such
scripts yourself. Not all web hosts allow scripts to be run on their server (computer).
3. Next, we have the "thank you" page. After the browser sends the message to the script, you will want
to thank your visitors for their email. Even if you don't feel particularly grateful, you will still need some
sort of page that will inform your visitors that their message has been successfully sent. This page can
be easily designed using KompoZer.
4. Finally, you will need an "error" page. If a visitor mistakenly clicks the "submit" (or "send") button
before he/she has finished typing essential elements such as their email address, the feedback form
script will direct them to a page telling them that they have missed out components required in a
message. Like the "thank you" page, this is a straightforward web page that can be designed with
KompoZer.
In other words, for your feedback form to work at all, you need five major things: the feedback form, the
feedback form script (program), the thank you page, the error page, and a web host that allows you to run
programs (scripts) on their computer.

Step by Step Guide
1. Get a web host with PHP 4.1 or above
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Your feedback form will not work at all if you use a web host that does not allow you to run your own
programs (scripts) on their computers. Basically, if you use the free web space provided by your
Internet Service Provider (such as AOL), or if you use a free web host, you will not be able to get your
feedback form working. Note that there are even some commercial (paid) web hosting that do not
allow you to run your own scripts.
If you are looking for a suitable web host, you need to find one that supports the running of PHP scripts
with an installed PHP that is version 4.1 or above. Generally, if a commercial web host supports PHP,
their PHP version will satisfy this requirement. Do not use free web hosts, even if they have PHP
support, since many of them do not allow PHP scripts to send email.

2. Generate a custom feedback form script
The next thing you will need to do is to visit thesitewizard.com's Free Feedback Form Wizard to
generate a customised feedback form script. The wizard can be found at
http://www.thesitewizard.com/wizards/feedbackform.shtml
Read through the Wizard's introductory page. Choose to create the PHP feedback form script.
Although you can generate any of the other types of feedback form scripts, for the sake of simplicity,
this tutorial will only focus on the installation and creation of a feedback form that uses the PHP
feedback form script.
In the next page, enter the information requested by the form. Modify the URLs supplied below to
contain your real domain. For example, if your domain is "such-and-such-a-name.com", use that
instead of the "example.com" given below.





Email: (enter your email address)
URL of Feedback Form: http://www.example.com/feedback.html
URL of "Thank You" Page: http://www.example.com/thankyou.html
URL of "Error" Page: http://www.example.com/error.html

Under the "Advanced Options (Optional)" section, click the drop down box for "HTML family to use"
and select "HTML". (This step is optional, so it's no big deal if you can't be bothered to set it.)
Finally, read the licence agreement. If you agree to the terms, indicate it in the form, and click
"Generate script" to continue.
Do not close the web page that appears. Leave it open while you work on the next few steps.

3. Saving the script
Start up an ASCII text editor without closing your browser. Windows users can simply start up Notepad,
which is found in your Start menu. Click the Start menu, followed by the "Programs" menu item (or "All
Programs" menu item if you use XP), the "Accessories" menu, then the "Notepad" menu item. If you
are a Linux user, you probably already know what an ASCII editor is; for example, you can use "Kate",
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"vi, "emacs", or one of the million editors available on Linux. It is important that you do NOT use a
word processor like Office or Word or the like.
Switch to your web browser, and locate the section that has the header "Feedback Form Script". Select
everything in the box below. If you are using Windows, one easy way is to simply click your mouse
somewhere in the box and type Ctrl+A (hold down the Ctrl key and type 'a'). Then copy the text you
have selected to the clipboard. You can use Ctrl+C in Windows, or use "Edit | Copy" from the browser's
menu.
Switch back to your text editor, ie, Notepad if you are using Windows. Paste the contents you copied
earlier. In Notepad, you can paste by using "Edit | Paste" from the menu. WARNING: Do not modify
anything in this page. Do not attempt to beautify it. Do not even attempt to add a blank line. This is not
the user-visible portion of your web page. We will come to that later.
Save the file as "feedback.php" and quit your editor. If you are using Notepad on Windows, please take
the following steps instead:









Click "File | Save As". A dialog box will appear. Navigate to the folder or directory where you
have kept all the web pages created in the earlier chapters. Name the file "feedback.php"
(without the quotes), and click "Save" to save in that same directory. Quit Notepad.
Unfortunately, in spite of what you specified earlier, Notepad automatically added a ".txt"
extension to your filename. You will have to manually rename the file to "feedback.php". To do
this, start up Windows Explorer and navigate to the directory where you placed
"feedback.php".
If the file appears as "feedback.php.txt" in your Explorer window, skip to the next step. If it
appears as "feedback.php" or "feedback", click the "Tools | Folder Options" menu in Explorer.
Click the "View" tab. Look for a setting "Hide file extensions for known file types" and uncheck
the box beside it to disable it. Click "OK". You should now be able to see the full filename
"feedback.php.txt".
Now click once on the filename "feedback.php.txt". Explorer will allow you to change the
filename. If this is not true, select the filename and hit the F2 on your keyboard. Delete the
".txt" extension, leaving the filename as "feedback.php" (without the quotes). Make sure there
are no trailing dots - that is make sure the filename is really "feedback.php" and not
"feedback.php." with a trailing dot.
When you hit the ENTER key, Windows will issue a warning about the dangers of changing
filenames. Allow the name change to take place.

4. Publishing (uploading) the script
To upload or publish the script so that it can be used by the pages on your website, you will need to
use a program for transfering files, called an FTP client (FTP stands for File Transfer Protocol).
KompoZer, up to version 0.7.10, does not seem to be able to transfer a script file that is associated
with a form despite what its "Publish" dialog implies. Basically, you will need a separate FTP client to
transfer ("upload") the "feedback.php" file from your computer to your web host's computer, so that it
can be used by your website. See below text (indented) for the how to upload this file. For non25 | P a g e - How to Design and Publish Your Website with KompoZer

Windows users will have to look for an FTP client and find out how to use it to upload the
feedback.php file to your web server. There are numerous free FTP clients available for many modern
operating systems.

How to Upload a File to your Website using the FileZilla FTP Client
The process of transferring a file from your computer to your website is often referred to as
"uploading" that file or "publishing" it. For web hosts that support FTP, or the File Transfer
Protocol, you need a program called an "FTP client" to transfer the file. This tutorial only deals
with how you can transfer a file to your web server using a free FTP client known as FileZilla.
Versions for Windows, Linux and Mac OS X are available. I will describe the Windows version of
this program, but if you use another operating system, chances are that it will work very
similarly.

Download and Install FileZilla
First, go to the FileZilla download page and obtain the appropriate version for your system. For
Windows, get the Setup version; at the time I wrote this, it's the one labelled "(recommended)"
under the Windows section.
Once you have downloaded the program, you will have to install it. Go to your desktop and
doubleclick the file that you have just downloaded. Follow the instructions to install it to your
hard disk.

Preliminary Steps
Before you can upload any file to your site, you will also need some information from your web
host. In particular, you will need to find out the following:





The name of the FTP server for your website. For example, your host may tell you that
your FTP hostname is "ftp.example.com".
Your user id or login username for your FTP account.
Your password for your FTP account.
The directory where you need to place your files so that they can be seen by a web
browser visiting your site. For example, your host may tell you to place the files in a
subdirectory called "www" or "public_html" or even the default directory that you see
when you log into your FTP site.

If your web host tells you that you do not have FTP access, you cannot use this tutorial. You will
have to use whatever method the web host has designated for you to upload your files.

Steps to Uploading or Publishing a File to Your Web Server
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For the purpose of this tutorial, I will assume that you wish to upload a file called
"feedback.php". Everytime you see "feedback.php" mentioned, you can substitute that name
with the name of the file you actually wish to upload. FileZilla does not restrict you to uploading
only files of that name. You can upload images (eg, GIF, JPG, PNG, etc), HTML files, video clips,
music files (eg MP3 files, WAV files, MIDI files), Perl scripts, PHP scripts, and so on.
1. Click the "File" menu followed by the "Site Manager" item on that menu. A dialog box
will appear.
2. Click the "New Site" button on that dialog box. This creates a new item under "My FTP
Sites" called "New FTP site". Rename "New FTP site" to the name of your site if you wish.
By default, the keyboard cursor would have been placed in the name portion of "New
FTP site" allowing you to change the name immediately. If you have lost the cursor
because you accidentally clicked somewhere else in the dialog box, you can get it back by
simply clicking once on the name. Note that this name can be anything you wish - it is
not required for accessing your site. However, you will probably make your life easier if
you change the name to that of your site rather than the cryptic "New FTP site".
3. Under the tab "General", enter the name of your FTP server in the "Host" input box. For
example, if your web host told you that your FTP hostname is "ftp.example.com", enter
"ftp.example.com" into the space provided.
4. Leave the "Port" and the "Servertype" entry boxes alone. Use your mouse and select
"Normal" from the drop down list box for "Logontype". This will enable the "User" and
"Password" boxes for the next step.
5. Enter your user id or your login name (or whatever your web host calls it) into the "User"
input box. Likewise, enter your password into the "Password" input box. Note that this
information is automatically saved onto your computer and will be re-used the next time
you run FileZilla, so you do not have to re-enter them again. (It also means that you
should not use FileZilla in this way on computers that others may have access to, such as
those found in an Internet cafe or a public library.)
6. Click the "Connect" button. FileZilla will proceed to log you into your server. If it is
successful, you will see a directory listing of your website's account in the right hand side
of the FileZilla window. The left hand side of the FileZilla window shows the directories
and files on your own computer.
7. If your web host told you to only upload in a specific subdirectory on the web server, such
as in the "www" or "public_html" directory, change to that directory by doubleclicking its
name in the folder portion of the right window pane (the "Remote Site" window pane).
FileZilla will open that folder and show you its contents in the files portion of the Remote
Site window pane.
8. Next, locate the file that you wish to upload in the left window pane (the "Local Site"
pane). Both window panes behave mostly like a Windows Explorer windows, so
navigating them should not be unduly hard. Once you have located the file you wish to
upload, say "feedback.php", doubleclick it to upload it to your website. Alternatively, you
can drag that file from the left window pane to the right window pane. The file will be
uploaded to the folder that is currently open on the right window pane, so make sure
you have changed to the directory you want before dragging the file there.
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9. As FileZilla proceeds to upload your file to your site, you should be able to see the upload
progress in the bottommost window pane in FileZilla. When the upload has completed,
you can disconnect from your website. Do this by clicking the "Server" menu followed by
the "Disconnect" item.

5. Creating the feedback form web page
By now, you should have no problem creating an ordinary web page. In fact, if you have been diligently
doing the things mentioned in the previous chapter on multiple-column layouts, you will already have
a four-page website (Home, About, Reciprocal Links, Site Map) with each page having a two-column
layout.
Copy the layout from the other pages that you have created and create your navigation panel as
before. If you are using the two-column layout from Chapter 4, put your cursor in the second column
and type the heading "Feedback Form" (without the quotes). You can beautify it in any way you choose
We will insert the feedback form generated by the wizard below that heading. If you are using some
other layout, put the heading in the appropriate portion of the page.
Now switch to the browser window that contains the generated code from thesitewizard.com's wizard.
This time locate the section in the output generated by the wizard that reads "HTML Code". Click in the
box below and select and copy everything.
Switch back to KompoZer. Click in the space under the "Feedback Form" heading that you created
earlier. Once you see your cursor blinking in the appropriate spot in the second column, click the
"Source" tab at the bottom of the Window. The HTML code for your page will be displayed. Don't move
the blinking text cursor and do not click anywhere in the HTML code portion. Select "Edit | Paste" from
the menu to insert the HTML code given by the wizard in the current location.
Click the "Normal" tab at the bottom of the screen again to view your form. The form should be
inserted in the correct portion of your page. You can now beautify your page any way you wish.
To widen the input field for "Name", click the field (the text-entry box) beside the words "Name:", and
select "Format | Form Field Properties" from the menu. A dialog box will appear for that field (box).
Click the button "More Properties" to expand the dialog box. The default field size as generated by the
wizard is "25". You can increase it if you want the field to appear wider, or decrease it if you want it
narrower. Note that this field size merely sets the appearance of the box on the screen. It does not
affect how much text your visitor can type into the field. Most browsers will simply scroll the text if the
box is not wide enough for what the visitor wants to type.
Similarly, you can change the size of the box underneath "Comments:". Click the box, select "Format |
Text Area Properties" and adjust the rows and columns to your satisfaction. As before, this change is
merely cosmetic, and will not affect the amount of text your visitor can enter.
The text appearing on the button can be changed as well. Right-click the "Send Feedback" button. That
is, click the right mouse button while your mouse cursor is over the "Send Feedback" button. A pop-up
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menu will appear. You can either ignore it and select "Format | Form Field Properties" from the main
menu or simply click "Form Field Properties" from the pop-up menu that appears. The "Field Value"
line in the dialog box that appears should display "Send Feedback", which is the text that is shown in
the button on the form. Change it to some other text if you wish.
Do not change any value other than those I mentioned above. Most importantly, you should not
modify the "Field Type" and "Field Name" values or the form will not work correctly.
When you have finished making changes, save your page as "feedback.html" with a title "Feedback
Form". You can change the title if you wish, but you should leave the filename as "feedback.html" since
this is the name you supplied to the Feedback Form Wizard earlier, and the script generated relies on
it.

6. Creating the "Thank You" and "Error" pages
To create your "Thank You" and "Error" pages, start with the layout that you created for the other
pages of your site and insert the navigation panel as usual. Then insert the appropriate text as outlined
below.
The "Thank You" page typically thanks your visitor for sending his comments. Its main purpose is to
provide feedback to the visitor that his comments had been successfully submitted. You can write
anything you wish for this page. For example, you might want to say something like "Thank you for
your comments. If your message requires a reply, I typically reply within 24 hours of the receipt of the
message."
The "Error" page is shown whenever the visitor submits the form without filling one of the fields. For
example, if he/she fails to enter an email address when the form is submitted, the "Error" page will be
displayed instead of the "Thank You" page. Your error page should inform the visitor that he/she needs
to complete all the fields in the form, and that he/she is to click the browser's "Back" button to go back
to the form to repair the error. For example, a possible message that you can use for your "Error" page
is "There were errors in the form that you submitted. Please complete all the requested information
before submitting the form. Click the 'Back' button on your browser to return to the form to fix the
error."

7. Publishing the Feedback Form, Thank You and Error pages
When you have finished designing your pages, publish them with KompoZer. If you have forgotten how
to do so, you may want to read chapter 1 of the KompoZer tutorial again.

8. Testing the Feedback Form
When all your files have been published, you should test your feedback form to make sure that it
works. If something goes wrong, check the Feedback Form Wizard FAQ (Frequently Asked Questions)
for the answer. You should also reread this chapter of the tutorial to see if you missed anything.
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How to Add a Background Image to Your Web Page
Steps to Inserting a Background Image
To add a background image to your web page do the following:

1. Copy the Image to Your Web Folder
The first thing you will need to do is to copy the background image to the folder (on your own
computer) where you placed your website's files. For example, if your index.html and other web files
reside in "c:\Documents and Settings\Desktop\website", copy the image into that folder. If you want to
separate your image from your HTML files, place them in a folder inside your website folder, eg
"c:\Documents and Settings\Desktop\website\images".
Do not leave your image in some other directory outside your web folder hierarchy if you want the
image to be properly handled and referenced by KompoZer.

2. Rename the Image to a Web-Friendly Name
If the filename of your image contains things like capital (uppercase) letters or spaces, rename the file
to something entirely in small (lowercase) letters without any spaces or punctuation marks. Otherwise
you may run into numerous problems later on. For those who are curious, you can find a description of
some of the possible problems mentioned in the article How to Create Good Filenames for Your Web
Pages.

3. Open the Web Page Where You Want to Place the Background Image
Now start KompoZer and open the page where you wish to insert the background image. If this is a
new blank page, be sure to save the page first (even though it is blank) before continuing. If you don't,
you will find one of the editor's options, namely the "URL is relative to page location" checkbox,
disabled later.

4. Add the Image to the Page
Click the "Format" menu in the web editor and select the "Page Colors and Background" item. A dialog box will
appear. Near the bottom of the dialog box, you should be able to see the words "Background Image" and a
blank field below that. Click the folder icon beside the blank field. The "Select Image File" dialog box will
appear. Select your background image and click the "Open" button.
You will be returned to the "Page Colors and Background" dialog box, where the name (and possibly folder) of
your background image has been entered for you in the "Background Image" field. Below that field, there
should be a check in the "URL is relative to page folder" option. Click OK to dismiss the dialog box, and you
should now see your background image on your web page.
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Note: if you find that the "URL is relative to page folder" option is unchecked and/or greyed out, it means that
you failed to save your file as mentioned in my earlier step. Click "Cancel" in such a case and go back to my
earlier steps and carry out those steps first.
Once you've done the above, you should be able to carry on designing your web page, this time with your
image as a backdrop to your site's main content.

Troubleshooting: What to Do If The Image Does Not Appear in a Published Page
If you find that the image appears in KompoZer when you edit the page on your own computer, but it does not
when you upload, look through the following checklist:

 Did You Place the Image in Your Website's Folder?
Did you place the image in the main folder of your website (or one of its subfolders) on your computer
as mentioned above? If not, start all over again. This time, make sure the image is copied to the folder
before you continue.

 Did You Save Your Web Page Before Inserting the Background Picture?
If you did not save your web page (even if it's completely blank) before inserting the background
picture, KompoZer will insert a "file://" reference to the image instead of the correct relative web
address. This will work on your computer, but not in a "live" website. In theory, KompoZer fixes such
references when you upload. However, if you manually upload using an FTP client, or you hit one of
the editor's bugs, it's possible that the web addresses (URLs) will not be correctly rewritten. My
recommendation is thus to save your page before inserting the background picture.

 Does Your Image Filename Contain Spaces or Capital Letters?
If your filename contains anything other than small (lowercase) letters and numbers, return to the
beginning again. This time, rename your file before continuing.
I know that some of my steps seem very strange (and unnecessary) to newcomers, and as such, they
sometimes omit certain parts. However, those steps are the result of years of hands-on experience and
are designed to avoid commonly-faced problems with KompoZer and with web creation in general.
Unless you already know what you're doing, it's honestly less of a hassle to follow those steps even if
they seem very stupid (like having to rename the file to remove spaces and capital letters). Once you
have a bit of experience dealing with KompoZer's foibles, you will be able to do things differently
without causing unexpected side effects. But the main thing is to get the page working first.
Experimentation can come later.
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How to Upload and Link to a PDF File (or PDF Ebook)
The Use and Abuse of PDF Files
PDF files are handy for publishing electronic books (ebooks) on a website. For example, some authors, in
addition to selling their printed book, also provide an electronic version on their website. Others publish a few
chapters of their book in a PDF form, as a form of teaser for their printed copy. These are acceptable uses of
the PDF format.
Do not, however, use the PDF format to substitute for things that should be ordinary web pages. For example,
don't make your entire website a PDF file or a series of inter-linked PDF files. PDF files create a poor user
experience on your website. Using them for your ebook is great, but don't use them to replace your normal
web pages.

Guide on Linking and Publishing a PDF File with KompoZer
1. Copy your PDF file into the folder on your own computer where you placed a copy of your website. To
make it less likely that you'll make a mistake later, you should probably place the PDF file into the very
same folder which contains the web page linking to it.
If you don't know how to copy a file and you use Windows XP, click the Start menu, followed by "My Computer"
on the menu that appears. Vista users will have to click the multi-coloured round button/icon on the bottom
left of your monitor, followed by "Computer" on the menu that appears. A window will open. Navigate to the
place where you have currently saved your PDF file. (I can't tell you where you saved it since I'm not psychic, so
you'll just have to find it yourself. Start by looking in your Desktop folder and your Documents (or My
Documents) folder since chances are higher that it is somewhere there.)
Once you've found the file, right click the file. That is, click your right mouse button when your mouse cursor is
over the file. A menu will appear. Click the "Copy" item on the menu that appears.
Then using the same window, navigate to the folder where you keep the web page that will link to the PDF file.
Again, I can't tell you where that is; only you will know where you've placed it. The folder probably has other
files inside, including a file called "index.html" or "index" (depending on whether you've configured windows to
show you the full filename).
Right click in a blank spot in that folder, and in the menu that appears, click "Paste". Windows will copy the file
to that folder.
2. Start up KompoZer and open the web page where you want to place the link.
3. Select the words on the page that you wish to make into a link to point to the PDF file. For example, if
you want to change the words "Download my PDF eBook" into a clickable link leading to your PDF
ebook, drag your mouse over those words to highlight them. If you haven't written any relevant
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phrases that you can change into a link, type some now (eg, type "Download my ebook") and select
them.
4. With the words selected, click "Insert | Link...". That is, click "Insert" from the menu, and then click
"Link..." on the menu that appears. A dialog box entitled "Link Properties" will appear.
5. Click the folder icon beside the blank "Link location" box. A dialog box labelled "Open HTML File" will
appear.
6. Near the bottom of that dialog box, click the down arrow for the "Files of type" field to reveal a drop
down box. Select "All Files" from that box. The list of files in the box will now show files of any sort that
are present in that folder. If you have followed my instructions earlier and copied your PDF file into the
same folder as the page you're linking from, you should be able to see it now. Click it to select it,
followed by the "Open" button. Then click the "OK" button.
7. The web editor should now show a blue underlined link in place of the normal text. (You can't click it
yet, of course, since you're still in an editor, and not a web browser.)
8. Save the page and publish it. KompoZer will proceed to publish your web page onto your website. At
this point, however, your PDF file has not yet been uploaded. Unlike the Dreamweaver web editor,
neither KompoZer (as of version 0.7.10) will upload the PDF file for you. You will need to manually
upload it yourself.
9. To do this, please see my guide How to Upload a File to Your Website Using the FileZilla FTP Client. The
article is a general guide on how to upload any file using a special type of program called an FTP client.
Simply follow its instructions to upload your PDF file. Be sure to upload it to the correct folder on your
web host; as mentioned before, put it in the same folder as the web page linking to it.
Note: if your site is a "live" website with an existing stream of visitors, you may want to defer the publication of
your web page till after you upload your PDF file. That is, first use the FTP client to upload your PDF file, and,
after it's done, use KompoZer to publish your web page. Otherwise, visitors arriving at the page between the
time you published it and the time you uploaded the PDF file may click the link only to get your 404 File Not
Found error page.
That's it. Once you've uploaded everything, start up your web browser and test the uploaded page. Click the
link to the PDF file. Depending on how you have configured it, your browser will either open the file within its
window or offer to save it onto your hard disk. If either of these things occur, it means that you have
successfully published your PDF file and linked to it.

How to Insert a YouTube Video into Your Web Page
Steps to Embedding a Video into Your Site Using the Supplied Embed Codes
1. Get the embed code
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After you upload your video to a video sharing site like YouTube, find the page where you can get the
embed code for the video. It can usually be found on the very page that the video is displayed. On
YouTube, just go to your video page. The code looks something like this:
<object width="425" height="350">
<param name="movie" value="http://www.youtube.com/v/tIBxavsiHzM" />
<embed src="http://www.youtube.com/v/tIBxavsiHzM" type="application/x-shockwave-flash"
width="425" height="350" />
</object>

Leave the web browser open on this web page.

2. Start Up KompoZer
Start up KompoZer and load the web page where you wish to place your video and move your cursor to the
portion of the page where the video should appear. You can do this by simply clicking the spot where you
want to place the movie. Make sure that there is a blinking text cursor in that location before you go to the
next step, otherwise click till you get it in the right spot.

3. Open the Insert HTML Dialog Box
Click the "Insert" menu followed by the "HTML..." menu item. A window should open. Switch to your web
browser, and select the embed code. Click the right button on your mouse and select "Copy" (or its equivalent
in your browser) from the menu that appears.
Return to KompoZer, and click the right mouse button again. This time select "Paste" from the menu that
appears. Click the "Insert" button to close the window.

4. Are You Getting a Blank Page or No Video?
You should be able to see a rectangular video window in the place where the video will appear. The video
itself will not appear, nor will there be any player controls.
In both cases, don't worry. If you inserted everything correctly, the actual code is on your page, even though
KompoZer does not display it correctly. When you upload it to your website and test it in a real browser, you
will be able to see your video.

5. Upload / Publish Your Web Page
Upload or publish your web page, and load the page from your site with your browser.
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How to Add a CSS Navigation Button Menu to Your Site
Nowadays, it's fairly common to see websites with a side or top navigation menu with buttons that change
colour when you hover your mouse over them. This tutorial deals with how you can create such a navigation
menu with buttons that show mouseover effects using the free WYSIWYG web editor, KompoZer.

How to Create a Button Menu with Rollover Menu Buttons
1. Creating the Navigation Menu Button CSS and HTML Code
Go to the CSS Navigation Menu Bar Buttons Wizard at http://www.thesitewizard.com/wizards/css-menubuttons.shtml and follow the instructions to create a button menu for your website. Customize the buttons
using the wizard to your heart's content. The wizard does all the hard work for us, by generating everything
you need for the button menu.

2. Saving the CSS Code for the Navigation Menu
i.

Without closing your browser, start up an ASCII editor. If you use Windows, you already have one on
your system called "Notepad". To start Notepad, click the "Start" menu, followed by the "All Programs"
(or "Programs") menu item, then the "Accessories" menu item. On that menu, click "Notepad".

ii.

Return to your web browser. Click your right mouse button somewhere inside the big box under the
section "Cascading Style Sheet (CSS) Code". A menu will pop up. Click the "Select all" item on that
menu. Everything inside that box should now be highlighted (selected).

iii.
iv.

Click your right mouse button inside the box again. Select the "Copy" item in the menu that pops up.
Switch back to the text editor (Notepad or the like) that you started up earlier.

v.

Paste the contents into the editor. To do this in Notepad, click the "Edit" menu at the top of the
window and select "Paste".

vi.

Now save the file with the name given in the Wizard. To find out the correct name, switch back to the
browser window. The name of the file is stated in the paragraphs just above the box you copied earlier.
For example, to save the CSS file using Notepad, click the "File" menu, followed by the "Save As" item
on the menu that appears. A dialog box will appear. In the "File name" field, enter the name given by
the Wizard, including the quotes. For example, if the wizard told you to use the filename
"tswnavbar.css" you must enter that name as given, including the quotes, otherwise Notepad will
change the name of your file behind your back.
Remember to save the file in the same directory as the main page of your website. For example, if your
main page was saved in the folder "c:\my-website", save your CSS file in that same directory.

vii. Close your text editor (Notepad or otherwise). You won't need it any more.
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3. Modifying the HEAD Section of Your Web Page
i.

Start up KompoZer and load the page you want to modify.

ii.

At the bottom of the KompoZer window, click the "Source" tab. KompoZer should now switch to
Source view, where you can see the actual HTML source for your web page.

iii.

Switch back to your browser. Scroll to the section "HTML Code for the <HEAD> Section" in the Wizard.

iv.

Click your right mouse button in the box below that, and click "Select all" in the menu that appears.
The text in the box should now be highlighted.

v.

Click the right mouse button again, and click "Copy" from the pop-up menu.

vi.

Switch back to KompoZer. Click your mouse in the space immediately after the word "<head>" (on the
same line). Hit the ENTER key (or RETURN key on the Mac). This will create a new blank line after the
<head> tag.

vii.

From the menu, click "Edit" followed by "Paste" on the submenu that appears. The line that you copied
earlier should be inserted into the KompoZer window.

viii.

Click the "Normal" tab button at the bottom of the KompoZer window to return to WYSIWYG view of
your web page.

4. Inserting the Button Menu HTML Code into Your Web Page
i.

Move your cursor in KompoZer to the part of the page where you want to insert your menu. One way
is to simply use the mouse to click on the spot you want.

ii.

Switch back to the browser window again and scroll down to "HTML Menu Button Code" section. Once
again, select all the code in the box and copy it. (See above steps if you have forgotten how to do it.)

iii.

Return to KompoZer. Click the "Insert" menu, and select the "HTML" item. In the dialog box that
appears, click your right mouse button in the box, and select "Paste".
Click the "Insert" button when you're done.

iv.
v.

The menu will not show up correctly at this point. To see the menu as it should appear, you will have to
upload or publish your pages to your website.

vi.

After publishing, load your web page in your browser, and you should be able to see your menu there.

Technical Note: KompoZer has some bugs in this area, so chances are that you will not see the
menu as it should appear in the web editor. Don't worry. Your page will show up correctly in a real
browser.
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How to Put an Order Form or Buy Now Button on Your Website
Using PayPal
If you are planning to set up an online shop, ie, a website to sell a product or a service, where the payment is a
simple one-time charge, this article describes how you can add a "Buy Now" button that leads to a secure
order form so that your visitors can purchase your product/service. They can use a credit or debit card for the
purchase, as well as any other payment method that PayPal supports.

Preliminary Things to Note
1. This article deals with how you can accomplish the task using a payment gateway called PayPal. You
are of course free to use other payment gateways if you wish, and a list of some of them can be found
in the How to Accept Credit Cards on Your Website article. However, since each payment processing
company has their own procedure for doing things, you will not be able to apply the steps listed in this
article to them.
In other words: this article only deals with how you can put the order form/button on your site using
PayPal.
2. Since you are selling things (or services), you will probably need to have PayPal's Business or Premier
account. Either of these allows you to accept unlimited credit card payments, among other things.
Note that the article assumes that you have already signed up for an account at PayPal. The actual
signing up is free, though PayPal earns by taking a small cut from each payment made through its
services. Please read their documentation for more information on that. The amount charged per
transaction varies from country to country.
For those who are not sure what a payment gateway is, please see the introductory article How to Accept
Credit Cards on Your Website. If you haven't already got a website, you may also want to refer to the The
Beginner's A-Z Guide to Starting/Creating Your Own Website.

Step by Step Guide to Creating an Order Button (Buy Now Button)
Note that the description of the web pages on the PayPal site given below were correct at the time I checked
them out. Since I don't control their website in any way (or control anything at all where their company is
concerned, for that matter), it is possible that the text may have changed by the time you read this. There may
also be localization differences. For example, PayPal may show slightly different things to different countries.
If you find that the words are different from what I describe here, get the gist of what I'm referring to and look
for the equivalent on PayPal's site. Over time, they are bound to change the words they use, update the site
design, or even move the links around a bit. But the basic idea should still be the same. (And if you have a little
time, please drop me a note to let me know of the changes so that I can update this article.)
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In addition, if you find that PayPal's documentation contradicts mine, you should probably trust PayPal's
documentation over mine. As I said, I neither work for PayPal nor control how they do things. I'm just a
webmaster like you. This article is meant to help you get started and answer a question that I get every now
and then from visitors to thesitewizard.com.
1. Log into your PayPal account.
2. Click "Merchant Services". At the time I write this, it is one of the links near the top of the window that
looks like a blue tab.
3. On the page that appears, look for the link that says "Buy Now Buttons". At the time this was written, it
was in the section labelled "PayPal Website Payments Standard".
4. A page entitled "Create a PayPal payment button" will appear. This page allows you to customize your
payment button and the associated order form.
5. The drop down box labelled "Accept payments for" lets you choose between "Products", "Services" or
"Subscriptions and recurring billing". This tutorial only deals with payments for products or services. If
you're providing a service that provides, say, monthly billing, you will have to read the PayPal
documentation yourself for more information. For now, select either "Products" or "Services",
depending on what you're selling.
6. In answer to the question, "Do you want your customers to buy multiple products before they check
out", select the radio button labelled 'No; create a "Buy Now" button'. This option is suitable for
situations where you have a single product or service. When your customers click the button, they will
be brought immediately to the page where they can enter their credit card information or log into their
PayPal account to pay.
7. Enter the "Item name" in the field provided. This name will be displayed in your order form for your
customers, so you should not put something cryptic that will mystify them and make them wonder
whether they have arrived at the wrong form.
Ignore the "Item ID" unless you know what you're doing.
8. Set the price in the "Price" field. The "Currency" field defaults to your local currency, but you can
change it if your prices are in a different one. Just click the drop down box and select the appropriate
currency if that's what you want.
9. If you need to charge for shipping and taxes, enter the required amounts in the fields given. PayPal
does not appear to provide automatic calculation of such things based on your location relative to that
of your buyer.
10. In the section "Merchant ID for purchase transactions", leave the default of "Secure merchant account
ID" unless you know what you're doing.
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11. I will not be dealing with the customizations that you can do in PayPal's "Step 2: Track inventory, profit
and loss (optional)". However, if you're interested, you can click that header to expand the section to
see if there's anything you want to customize. Be sure to read the PayPal's documentation for more
information about those fields. If you don't understand what you're reading there, just leave
everything set at the defaults.
12. Click the line that says "Step 3: Customise advanced features (optional)". This expands a section that
lets you customize the checkout pages. Like "Step 2", you can actually leave everything set at the
defaults, and your order form will work just fine, albeit using the PayPal default checkout pages.
For those who want to fine-tune their order form, read on:
o If you want to allow your customers to order more than 1 unit of the product you're selling, set
the answer to "Do you want to let your customer change order quantities" to "Yes". Otherwise,
leave it at "No."
o If you want your customers to be able to add "special instructions" to their order, leave the
"Yes" radio button for that item selected, otherwise click "No". Since you're selling something,
you may want to provide that special instructions field for your customers in case they have
specific requirements that you did not anticipate in your planning.
o If you do not want your customer's postal address, click the "No" radio button for that field,
otherwise leave it set to "Yes".
o The next two fields, "Take customer to a specific page (URL) after checkout cancellation" and
"Take customer to a specific page (URL) after successful checkout" are for people who want to
customize the landing pages for a successful order or a cancellation. You will of course have to
create those web pages on your site yourself, and put the web address for those pages here. If
you don't know how to do that, leave these fields alone.
13. When you're through customizing your "Buy Now" button and your Order Form, click the "Create
Button" button.
14. A new page giving you the generated HTML code appears. You will need to copy the code given in the
field to your web page. To copy the code, click somewhere in the box containing the generated code.
The text in the box should automatically be selected. Click your right mouse button in that field and
select "Copy" from the menu that appears.
15. You will need to paste that code into the correct spot on your web page. See below for that
information.

What if I Change My Mind About the Settings I Made for the Button or Order
Form?
PayPal saves the button, along with its settings, in your account. If you want to modify the settings after you
create the button, for example, if you want to change the product price or the landing page web address, go
to the "Merchant Services" page again and click the "Buy Now Buttons" link as before. This time, instead of
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creating a new button, look for the link that says "Go to My saved buttons". At the time I write this, it's located
below the first field, "Accept payments for".
When you do this, a new page, called "My Saved Buttons", will appear. Click the "Action" button for the saved
button you want to modify. A drop down menu will appear, allowing you to "Edit" the button to change the
settings, "Delete" the button, "View code" if you need the HTML code for the button again, and so on. To
change the settings, click the "Edit button" item. You'll be brought to the page that you saw earlier, where
you'll be allowed to change some settings.
(Not all settings appear to be changeable. For example, the "Accept payments for" setting is not. If you really
need to change that, you'll probably have to create a new button.)
That's it. Your site now has a "Buy Now" button that leads to an order form. With this, you have an online
shop that can now start accepting credit card payments (along with the other payment methods provided by
PayPal).

How to Insert Raw HTML Code
Although you may be using a WYSIWYG web editor like KompoZer to create and maintain your website, you
may find that, on occasion, you need to insert a snippet of raw HTML code into your web page. For example,
you have may come across some code from, say, thesitewizard.com's Link To Us page. If you have tried
inserting such code simply by pasting it into your page using KompoZer, you would have found that your page
displays the raw HTML code instead of the actual text or button you want.
This tutorial takes you through the steps of inserting such HTML code into your web page. I will assume here
that you already know how to use KompoZer for creating and publishing a website using the WYSIWYG
interface. As such, this article merely supplies the missing information on how you can insert third party cutand-paste HTML code. If you are not sure how to use KompoZer, you may wish to start at the beginning with
the article How to Design and Publish Your Website with KompoZer.

Steps to Inserting Cut-and-Paste HTML Code into your Site
1. Start up KompoZer and open the page that you want to edit. To do this, click "File -> Open File", that is,
click the "Open File" item on the File menu.
2. Click the spot on the page where you wish to insert the HTML code.
3. Switch to your browser and surf to the page where you can get the cut-and-paste HTML code. Select
the code and copy it to the clipboard. To do this, drag your mouse over the HTML code to select all of
it, click the right mouse button on the text and click the "Copy" item on the menu that appears.
4. Return to KompoZer. Click "Insert -> HTML...". That is, click the "HTML..." item on the "Insert" menu.
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5. A dialog box will appear. Click somewhere in the empty blank space. Right-click (that is, click the right
mouse button) and select "Paste" from the menu that appears. The HTML code should appear in the
box. Click the "Insert" button.
6. The code will now be inserted into your web page. If this was a button from, say, thesitewizard.com's
Link To Us page, the image of the button will appear in your window and not the raw HTML code you
saw earlier.
Voila, you're done. You can now save the file and upload it to your website.

How to Add Google AdSense Advertisements to Your Website
This tutorial shows you how you can add Google advertisements (officially known as Google AdSense) to your
website using the free web editor KompoZer.

Requirements
An Existing Website
This article assumes that you already created a website. If you haven't done so, please check out the
Beginner's A-Z Guide on How to Start Your Own Website. That tutorial guides you through all the steps needed
to start your website and get it published. For the actual design of your web pages using KompoZer, see my
KompoZer Tutorial series. Both guides are needed, since website creation involves more than just designing
the web pages.

Sign Up for Google AdSense
Before you can put Google adverts on your web page, you will need to sign up for an AdSense account. You
can find AdSense listed among other advertisers on thefreecountry.com's Affiliate Programs: Free Sponsors
and Advertisers page. A detailed account of the whole procedure can be found in my article How to Add
Google Advertisements to Your Blog or Website.

Step-by-Step Guide to Inserting Google Ads
1. Click "AdSense Setup" in your Google AdSense account. In the page that loads, click "AdSense for
Content". From there, you will be led through a series of steps to choose the type of advertisement
and customise its size and colours. These options allow you to modify the appearance of the advert so
that it blends nicely into your site's design.
When you have finished customizing, click "Submit and Get Code". AdSense will then give you some
HTML code to cut and paste into your web page. Click anywhere inside the box containing the code.
The code will be automatically selected. Click your right mouse button and select "Copy" from the
menu that appears. This puts the code into your clipboard, so that you can paste into your website in
KompoZer.
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2. Run KompoZer if you have not already done so. Open the web page where you want to insert the
advertisement.
Choose a place on your page where the ad is to be inserted. Google does not restrict you on the
placement of the ad, so you can put it anywhere you like. Some common places where ads are placed
include the top, bottom and side panel of a web page. In general, adverts placed in prominent places
(such as those embedded in the middle of an article) tend to attract more attention, and thus earn
better.
I should warn you, however, that "in your face" advertisements, where the adverts have placements
that force your visitors to look at them, are also very irritating to many people. You should also weigh
the benefits of increased income against the cost of aggravating your visitors when deciding.
Another thing to watch out for is that Google limits the number of AdSense "units" you can place on a
page. Read the Terms of Service for the exact number. Regardless of the number though, it's best not
to load your page with too many ad units. If there are too many, your website may look cheap, even if
your content is actually of very high quality. (There is no hard and fast rule here. Just check your web
page in your browser when you've finished, and try to be impartial when judging your own page.)
3. Once you have decided on the ad placement, click the spot on the page where the advertisement is to
be shown. The blinking text cursor should appear in that spot. Next, click the "Insert" menu followed
by the "HTML..." item on the menu that appears.
4. In the dialog box that is shown, paste the code you copied from Google into the empty space. This can
be done by clicking the right mouse button somewhere in the space and selecting "Paste" from the
menu that pops up. Your AdSense code will appear in the box. Click the "Insert" button to dismiss the
dialog box.
5. KompoZer does not actually display the advertisement, but indicates you that you have successfully
inserted the code by showing one or more yellow "Script" tags in the location where the ad will appear
in your real website.
If you want to insert more than one ad unit into your page, repeat the procedure I provided above.
Once you've finished, publish the web page to your site in your usual way.
6. After your page has been published (uploaded), you will need to test it. Start your web browser and
surf to the page on your website. Important: in order to see your advertisement, you need to be
checking your "live" page on your website, and not the local copy on your own computer.
If the ad does not appear at first, wait a while and then reload the page and the advertisements should
appear. The slowness of the advertisement to show up on your website is generally a one-time thing.
The first time Google encounters a new page, it sends its "bot" (computer program) to retrieve a copy
of that page. From that copy, it tries to determine what your web page is about, so that it can deliver
advertisements that may be relevant to people seeing such content.
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Troubleshooting Problems in KompoZer
How to Solve the "Publishing Failed. Unknown Publishing Error
Occurred" Error in KompoZer
If you are setting up a website for the first time using KompoZer, and you get the uninformative error message
"Publishing Failed. Unknown publishing error occurred", know that you are not alone. Here are some pointers
as well as a last resort measure to help you work around the problem.

The First Thing to Try
Make sure that you know what the various fields in the Publishing dialog box really means. If you are not sure,
go back to the main part of the manual explaining how to create a page and check you have followed those
steps properly. Understanding the dialogue boxes in your first steps can be a very useful step in getting where
you need to be.

Other Steps to Try
1. Restart KompoZer After Changing Settings
After changing settings in the Publishing dialog box in KompoZer, quit the program and then restart it. If you
don't, it may continue using the old settings in spite of your changes.

2. Check Your Login, Password and Directories
Use an FTP program to see if you can connect to your site. Using the FTP program will help you verify a few
things:
Did you get the login name (or username) and password correct?
Did you get the publishing address correct? Remember that the publishing address includes the initial
directory. If you had to change directory in your FTP client to get to your web files, it means that you need to
include that directory in your publishing address in KompoZer.

3. If You Are Publishing to a Subdirectory or Folder
If you are publishing your site to a subdirectory (folder) on your server rather than to your main web directory,
connect using your FTP program and create the folder beforehand. This may (or may not) solve the problem.

4. Quit All Other FTP Programs Connected to Your Site
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If you have used an FTP software to check your settings or create a folder, then make sure you quit it before
retrying KompoZer. And while you're at it, quit KompoZer as well, and restart it before testing again. Some
web hosts, particularly the free web hosts, prevent you from having more than one FTP connections to your
site. If you have an FTP program running at the same time as KompoZer, the host will see an existing FTP
connection, and refuse the one that KompoZer is trying to make. Note that it is sometimes not enough to
disconnect from your site in the FTP client. You should quit the program altogether in case the program is still
maintaining the connection behind your back.

The Last Resort
As a last resort, consider creating your website on your own computer using KompoZer, and using an FTP
program to upload it. If you have managed to successfully access your server earlier using an FTP client (see
above), it means you already know how to use FTP and are no longer dependent on a WYSIWYG web editor to
handhold you through that aspect of web publishing.
If you decide to use the FTP software to upload your files, make sure that you check all the links on your web
pages in the "Source" mode of the editor. To do this, click the "Source" tab at the bottom of the web editor's
window. Scan for all references to "href" and "src" to make sure that none of them point to destinations
beginning with "file://". They should have relative addresses like "index.html" or "../images/tsw88x31tut.gif"
or a fully-specified URL like "http://www.example.com/images/tsw88x31tut.gif".
For the curious, the "file://" references are normally fixed by the editor when it is uploading, but since you are
not going to be using KompoZer to publish, you need to fix them yourself. And remember to upload all your
images, stylesheets and other files as well. Since you are doing it manually, you will no longer have the web
editor to track all the dependent files for you. Be sure to upload them to the correct directories as specified by
the "href" and "src" attributes. Or change the href/src accordingly to point to where you want them uploaded.
Diagnosing the cause of the vague "Unknown Publishing Error" messages can sometimes be quite tricky. The
tips given here can help you to either fix the problem or provide you with a workaround so that you can get
your website published on the Internet.

Why Do the Pictures on My Web Page Not Show Up in
KompoZer? Troubleshooting the Broken Images on Your Page
Reasons for the Missing Graphics on Your Web Page
The problem is caused by different factors, possibly triggered in some cases by bugs in KompoZer and in
others by user errors.
There are two basic reasons why you see a broken image icon in place of your actual picture on your site:

1. The link pointing to the location of the image is wrong.
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This often happens if you don't publish your page at the very beginning KompoZer does not know the real URL
of your website. The web editor will then insert a reference to the image on your own hard disk instead of a
reference to it on your website.

2. The files were not actually uploaded.
If the image files were somehow not uploaded by KompoZer to your website, then the links to those pictures
on your web page will point to nowhere, leading to the broken image placeholder.
It is even possible that both these reasons are true at the same time.

How to Fix the Broken Image Problem
There are two parts to repairing the missing graphics problem.

1. Fix the Links to Your Images on Your Web Page
Open your web page in KompoZer. For each image on your page, right click the image and select "Image
Properties" from the menu that pops up.
Look at the field for "Image Location". If you see a location that begins with "file:///", it means that your
web page points to the images on your own computer's hard disk instead of on your website. In theory,
KompoZer should change these references to relative URLs like name-of-your-picture.jpg or foldername/name-of-your-picture.gif when you publish your site. Since you're reading this troubleshooting
guide, you will already know that this doesn't always work correctly, particularly if you don't publish your page
prior to inserting an image.
Essentially, you will have to change these references manually to point to the correct location. If you placed all
your images in a folder called "images" in the main directory of your website, then change the location to
http://www.example.com/images/your-image-name.gif. You should of course change
"www.example.com" to your real domain name, "images" to your real folder name, and "your-imagename.gif" to the real filename of your graphic.
Do this for every image on your site.
Incidentally, if none of your images contain locations that begin with file:///, it's possible that the links are
already correct. In that case, just move on to the next step.

2. Upload all Your Pictures to the Correct Folder
The next thing you need to do is to upload your pictures to your website. Since the web editor appears to have
failed to do so, either because of a bug or an error on your part, you will have to do this manually.
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The best way is to use a program known as an FTP client. This is a special program that allows you to connect
to your website's directories directly, look at what's there, upload new files, delete files and so on. As a
webmaster, knowing how to use an FTP software is an invaluable skill, since you'll sometimes need to do more
things with your site than a web editor will allow you. (For example, KompoZer does not provide a facility for
you to delete files on your site.)
Read the information on If you don't know how to use an FTP program, please see the guide How to Upload a
File to Your Website Using the FileZilla FTP Client. Use the guide to upload your pictures to your website.
Be sure to put the images in the correct folders on your site when you do.

Recommendations to Minimise Future Problems
Although some new webmasters don't like the sequence of steps I take in my beginner KompoZer tutorials
there is actually a method to the madness.
The tutorials make you publish your web page even before you have much useful content on it. In particular,
the pages get published even before a single image or normal link is placed on it. Although this is not a
foolproof method to avoid problems, it seems to help to avoid broken links being created by those web
editors.
KompoZer's linking and publishing facility are not particularly sophisticated. They can easily fail for inexplicable
reasons or not do the (humanly) obvious in other situations. As such, even though it may make you cringe to
upload a near-empty web page to your site when you start, you should consider doing it to minimize the
broken images and links problem. It's not guaranteed to eliminate the problem completely though, so you
should still check your website after publishing.

How to Prevent Your Images or Text from Going Out of
Alignment When Your Visitors Resize Their Web Browsers
Reason for the Misalignment
If your site faces a problem of graphics or text being misaligned under certain resolutions, it means that you
have created a site that is dependent on a particular width.
In such cases, you should change your site to use fixed widths, rather than relative widths.

How to Use a Fixed Width for Websites Using Tables for Layout
For sites that use tables to create a multi-column layout, do the following.
Start up KompoZer and click a spot somewhere in one of the table columns, so that the blinking text cursor
appears inside the table.
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Click the "Table" menu, and select the "Table Properties..." item from the menu that appears. A dialog box
with the caption "Table Properties" will appear.
Look at the line that shows "Columns". The "Width" field of that line probably shows something like "100% of
window" or some other figure in percentage. This is the value that you need to change. Percentage is a
relative measurement. 100% of a 1024x768 monitor is narrower than, say, 100% of a 1680x1050 monitor.
What you need is to set the width of your window in pixels.
To do this, click the drop down box for "% of window" and select "pixels" instead. Now change the "100" (or
whatever number that was in the box before) to a number that is suitable for your website. If you're not sure
what number to enter, try putting in some random number, save your web page and load it in your browser to
see if it looks okay. Keep adjusting that number until the output in your browser has the appearance you
want.
Note that the width you need will probably not be the same as your screen resolution. That is, for a screen
resolution of, say, 800x600, the width of the visible portion of a displayed web page is unlikely to be 800
pixels, since the edges of the browser window take up some space.
When you've finished, click OK to exit the dialog box.
You have now fixed the total width of the table. However, depending on how you have created your layout,
you may also need to resize the individual columns of your site. To do that, put your cursor in the column you
want to configure, and then select "Table Properties..." from the "Table" menu again. This time, when the
dialog box appears, click the "Cells" tab on the top of the window. The resulting dialog box allows you to
change the width of the column to a number that suits your site's design. You can use either pixels or
percentage here. As before, if you are not sure what value to use, just experiment with some number and
adjust till it is to your satisfaction.
To adjust the widths of the other columns, if needed, click your mouse somewhere in that column to place the
text cursor, bring up the "Table Properties" dialog box again, and do the same thing as before.
Once you've finished setting the fixed width, you will need to centre your table. Now that your table no longer
fills the width of the screen, if your page is viewed in a maximized browser window on a large monitor, you
will find that it is flushed to the left of the window. To solve this, see the article How to Centre a Table Using
CSS in KompoZer.

How About Sites that Use CSS for Layout?
(For those using tables to define your site's layout, please skip this section.)
If you are using CSS to create a multi-column layout for your website, chances are that you did not rely solely
on KompoZer's WYSIWYG (What-You-See-Is-What-You-Get) interface, since KompoZer has weak support for
creating and maintaining multi-column CSS layouts. In other words, if you used CSS to create your own layout,
I can probably assume that you know the basics of CSS, and don't really need a lot of hand-holding. All you
probably need, in such a case, is to know where to look to fix your code. So, for such people, I'll just mention
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that you need to set the width property for your DIV blocks with a pixel value (instead of "%" or "em"). For
example, if the containing DIV block for your two columns has an id of container, do the following to make
that column have a fixed width of 750 pixels.
#container {
width: 750px ;
}

After setting the width of your various columns, you will also need to centre your DIV block. To do this, see my
article How to Centre a DIV Block Using CSS.
As you can see, changing a site to use a fixed width in KompoZer is a simple task. With the above steps, the
content of your site need no longer be misaligned in browser windows larger than the one you designed for.

How to Delete a Web Page from Your Website: Removing an
Already Uploaded File
While it's obvious how you can create a new web page, the same cannot be said about removing one that
you've already designed and uploaded to your site. Or at least, it's usually not obvious to newcomers. Since
visitors sometimes ask me how this is done, this article delves into how an unwanted web page on your
website can be deleted. Note that you can make use of the procedure given in this article no matter which
web editor you happen to use.
Although KompoZer 0.7.10 has a rudimentary site manager of sorts, it doesn't do most of the things done
automatically by Dreamweaver. But don't worry. It's still very easy to delete a file you've uploaded. You will
need an FTP. I will explain here using FileZilla.
Anyway, the step by step guide for using FileZilla is given below.
1. After you've installed Filezilla, start it.
2. If you are greeted with a dialog box asking you to report any bug you find, just click the "OK" button. If
you don't see this dialog box, don't worry. Just move on to the next step.
3. At the top of the FileZilla window, you will see a line that says "Host:", "Username:", "Password:" and
"Port:". You will need to enter the information relevant to your website in these 4 fields.
Enter your website's FTP server hostname into the "Host" field. To find out what your FTP server name
is, either ask your web host or look into the email that your web host gave to you when you signed up
with them. Some web hosts call this the "FTP server name" or something like that. Very often, if your
website's domain is called "example.com", your FTP hostname is "ftp.example.com", but this is by no
means guaranteed. Different web hosts have different methods of giving you FTP access, so don't just
make a guess and type some random name here. It won't work. If you can't find the information
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yourself from your web host's email or online documentation, ask them. Note: do NOT type "http://"
or "ftp://" or anything preceding your hostname. Just type the FTP host name by itself.
The "Username" and "Password" is the FTP user login name and password that is supplied to you by
your web host. Again, if you don't know what these are, ask your web host. There's no way anyone else
can tell you what they are.
Enter "21" (without the quotes) into the "Port" field. (The only time you should enter a different
number into this field is if your web host specifically tells you to use a different FTP port. This is so rare
that most people should be typing "21" here.) I think FileZilla defaults to using 21 if you forget to type
anything into this field, so you may not even need to fill it in. If in doubt, just type it in.
4. Click the "Quickconnect" button.
5. A series of messages will appear in the top part of the FileZilla window. As a beginner, you can ignore
them. If you have entered all your site's particulars correctly earlier, you will be successfully connected
to your website, and the right panel underneath the list of messages should show a directory listing of
all the files and folders on your website.
6. Locate the file you want to delete. If you cannot immediately spot it in the right panel after scrolling up
and down, see if you can find a folder called "www" or "public_html". If so, doubleclick that folder to
open it. If you see both "www" and "public_html", you can probably doubleclick any of them, since one
of those names is probably just an alias for the other. If you see neither, and cannot find the file you
want on your own, ask your web host for help.
7. When you've located the file you want to remove, click it once to select it. Then click the right mouse
button while your mouse pointer is hovering over the file. A menu will appear. Click the "Delete" item
in that menu.
8. A dialog box, with a title of "Confirmation needed" and a message of "Really delete 1 file?", will appear.
Click the "Yes" button if you want to really want delete the file. FileZilla will then proceed to erase the
file.
9. Finally, click the "Server" menu at the top of the FileZilla menu. In the menu that appears, click the
"Disconnect" line.
Now that your file has been removed, try to load that page in your web browser by typing the web address to
that file. You should get a 404 File Not Found error. If you instead still see the page you've supposedly deleted
earlier, try clicking the "Reload" or "Refresh" button in your web browser. You could be seeing an old copy of
your web page cached by your browser.
If after reloading, you still see the file, use another web browser that you don't normally use to test that web
address. For example, use Opera (if that's not already your normal browser). You'll want to do this to make
sure you're not really seeing a cached copy of the page. The "Refresh" / "Reload" button doesn't seem to
always force a reload of the page in some browsers (notably Internet Explorer, or at least, older versions of it).
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After doing all this, if you continue to get your old page instead of a 404 error, you'll have to consider other
possibilities. You may have multiple copies of the file stashed on your website, and have only deleted one of
them. Alternatively, you may have deleted the wrong file. Or you may be accessing your site through a proxy
server and your proxy has cached a copy of the old page. (Some Internet providers do this in a manner
transparent to you, so you may not realize that you're surfing through a proxy.) To make sure that you haven't
made a mistake in deleting your file, connect back to your site with FileZilla and thoroughly go through folder
by folder to make sure that the file is well and truly gone. There's not much you can do in the case of the use
of a proxy except to wait till the next day and hope that the proxy will load your page directly instead of
serving it from its cache.

Oops! I've Changed My Mind...
Once you've deleted the file from your server, chances are that it's gone with no hope of recovery. Remember
that this deletion is taking place on your web host's computer, and not your own. If you have a change of
heart, you can't even resort to using one of those undelete utilities to resurrect your file.
As such, for the sake of your own sanity and health, if you think you may regret the file removal at some point
in the future, make a backup of the file somewhere before you do your deleting. For example, create a folder
called "obsolete web pages" on your computer and put a copy of your soon-to-be-deleted file there for
safekeeping. You can always purge that folder after a period of time when you are really sure that you no
longer need its contents. To use an old cliché, it's better to be safe than sorry.
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